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A Living Tradition in Sound

A piano comes into this world through the perfect synergy of advanced technical
skill and artistry. Such a piano can create sound that truly reflects the player’s
feelings.

The final stage in piano production is called “voicing”. It is here that the
instrument is given its soul.

A highly skilled expert concentrates his mind and sensitivity on the sound of each
key, finely adjusting the dynamic feel of the hammers, bringing the tone and
vibrancy of all 88 keys together perfectly; a truly stunning achievement.

It is a quality of sound that can only be determined by an astute, sensitive ear. We
apply this very same concept to the manufacture of our audio products. The
technician performs exhaustive listening tests and every component is considered,
in order to finally achieve the ideal sound.

Yamaha’s tradition of audio quality stretches back over 125 years, and continues to
live on in all Yamaha products today.




Excellence in Audio Achievement

1920- First HiFi System introduced in 1920

1 96 0s We introduced numerous HiFi components
(turntables, FM/AM tuners, integrated
amplifiers, preamplifiers, power amplifiers
and speakers) in 1955 - 1965.
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NS-20 CA-1000
Natural Sound Speaker Series introduced
in 1967

NS-20 Monitor Speaker

CA-1000 Integrated Amplifier
Featuring A-Class operation, the CA-1000 set
the standard for integrated amplifiers.

NS-690 Natural Sound Speaker

NS-1000M Monitor Speaker
A truly legendary speaker still revered by HiFi
enthusiasts.

1970s

B-1 Power Amplifier
An innovative power amp that used vertical FETs in all
stages.

C-2 Control Amplifier
Received top prize at the Milan International Music
and HiFi Show.

NS-10M Studio Monitor Speaker
Became of the most popular studio monitors
in the world.

A-1 Integrated Amplifier

PX-2 Turntable
Yamaha’s first straight arm turntable.

1980s

B-6 Power Amplifier

Pyramid-shaped power amplifier.

GT-2000/L Turntable

First CD Player (CD-1) introduced in 1983
B-2x Power Amplifier

MX-10000 Power Amplifier and
CX-10000 Control Amplifier

Redefined the capabilities of separate components.

AX-1 Integrated Amplifier

1990s

GT-CD1 CD Player

MX-1 Power Amplifier and
CX-1 Preamplifier

20005 s+ Soavo-1and Soavo-2 Natural Sound
Speaker Systems

A-S2000 Stereo Amplifier and
CD-S2000 Super Audio CD Player

NP-S2000 Network Player

2010:s
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Full-stage balanced signal transmission beginning with the DAC
achieves the ultimate in CD reproduction

Independent power supplies with digital and analog completely
separated

Exclusive Yamaha loading mechanism and high precision CD drive
Left-right symmetrical design with rigid, stable construction

Pure Direct

Super sound from Super Audio CDs

Heavy feet with newly-developed antivibration spikes

DSD playback via 192 kHz, 24-bit USB DAC

Supplied accessories

Please check that you have received all of the following parts.

Power cable

Remote control

Batteries (AAA, R03, UM-4) (x2)
Stereo pin cable

* SAFETY BROCHURE
Contents

Controls and functions 6
Connections 18
Playback of music files stored on a PC 22
Specifications 26
Playable disc format 27
Troubleshooting 29

B About this manual

* 3¢ indicates a tip for your operation.
* The color of images in this manual may vary from the original.
* Read the “SAFETY BROCHURE” before using this unit.
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CD-S3000

Controls and functions

In this chapter, you will learn the controls and functions of CD-S3000.




H Front panel (pages 6 to 9)
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(1 STANDBY/ON/OFF switch
Turns on or off this unit.

STANDBY/ON (upper position):
In this position, you can select STANDBY or ON,
using the () CD key on the remote control.

OFF (lower position):
The power of this unit is turned off.

Notes

« When you turn on this unit, it will take a few seconds
before this unit can reproduce sound.

« If this unit is not operated for 30 minutes with no audio
signal detected, it goes to STANDBY mode (page 15).

« If you disconnect the power cable from the AC outlet and
connect it again when this unit is in STANDBY mode, the
power of the unit is turned on (page 20). If the unit is not to
be operated for a long time, set the STANDBY/ON/OFF
switch to OFF.
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(@ STANDBY/ON indicator

Lit brightly:

Shows that the power of the unit is ON. In this
condition, you can switch the unit to STANDBY mode
using the ) CD key on the remote control.

Lit dimly:

Shows that the unit is in STANDBY mode. In this
condition, press the () CD key on the remote control
to turn on the unit.

Off:

Shows that the power of the unit is OFF. In this
condition, you can turn on the unit using the
STANDBY/ON/OFF switch only.
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® PURE DIRECT key

Turns on the PURE DIRECT mode to improve audio

quality.

When this unit is in the PURE DIRECT mode:

» No signal is output from the DIGITAL OUT
(OPTICAL and COAXIAL) jacks on the rear panel
(page 10).

+ The least indicators and messages appear on the
front panel display.

¢

* Press this key again to turn off the PURE DIRECT mode.

« This setting is retained even if you turn off this unit.

PURE DIRECT indicator
Lights when the PURE DIRECT mode is turned on.

®

SOURCE key

Selects the audio source to be played back. Each time
you press this key, the audio source is switched.

DISC USB
(SA-CD/CD)
COAXIAL OPTICAL «—

(coaxial digital input) (optical digital input)

R

The audio source setting is retained even if you turn off this
unit.

SOURCE indicators

The indicator of the audio source selected with the
SOURCE key lights.

LAYER key

Switches the playback layer of a hybrid Super Audio
CD between SA-CD and CD while playback is
stopped (page 27).

R

This setting is retained even if you turn off this unit.

Note

When SA-CD layer is selected, audio signals are output only
from the BALANCED OUT and ANALOG OUT jacks.

LAYER indicators
The indicator of the layer selected with the LAYER
key lights.
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H Front panel (pages 6 to 9)
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(@ Disc tray
Loads a disc.

A (Open/Close) key
Opens or closes the disc tray.

R

The disc tray also closes automatically when you press:

« the > (Play) key on the front panel or on the remote
control.

« the front edge of the disc tray gently.

 a numeric button on the remote control.
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@ ~==</<1<a (Skip/Search backward) key

Press the key once to skip back to the beginning of the
current track.

Press it twice to skip to the beginning of the previous
track.

Press and hold it to search backward.

=/ (Skip/Search forward) key
Press the key once to skip to the next track.
Press and hold it to search forward.

= (Play) key
Starts playback.

o0 (Pause) key
Pauses playback. Press the = or 00 key to resume
playback.

3 (Stop) key

Stops playback.
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i Remote control sensor
Receives signals from the remote control.
R
The remote control transmits a directional infrared beam.
Be sure to aim the remote control directly at the remote

control sensor on the front panel of this unit during operation.

ool000
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Approximately 6 m (20 ft)

l

Display
The brightness can be adjusted with the DIMMER key
on the remote control (page 12).

@ > (playback)/ oo (pause) indicator
Lights in the playback/pause mode.

Disc type indicator

Indicates the type (SA-CD/CD/HYBRID) of the disc

in the disc tray.

Time display mode indicator

Indicates the time display mode of the display. Change
the mode by pressing the DISPLAY key on the remote

control (page 13).

J

TRACK: Elapsed time of the current track

TRACK REMAIN: Remaining time of the
current track

disc

@ Playback mode indicator
Indicates the current playback mode.
PROG: Program playback (page 14)
SHUFFLE: Shuffle playback (page 13)
REP OFF: Repeat playback off (page 12)
REP S: Single repeat playback (page 12)
REP ALL: All repeat playback (page 12)

@ Information display

TOTAL REMAIN: Total remaining time of the

See page 28 for more information on MP3/WMA
playback.
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B Rear panel
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See page 18 for connection information.

SYSTEM CONNECTOR

Use this connector to connect a product testing device

(1 BALANCED OUT jacks (male)
(@ ANALOG OUT jacks

3 DIGITAL IN USB jack (Type B)
(@ DIGITAL IN OPTICAL jack

(® DIGITAL IN COAXIAL jack

(® DIGITAL OUT OPTICAL jack
(» DIGITAL OUT COAXIAL jack

Note

While playing the Super Audio CD layer, the audio signals are
output only from the BALANCED OUT and ANALOG OUT
jacks.

10cn

for servicing.

® REMOTE IN/OUT jacks
Use these jacks to connect an external component for
remote operation.
For details on the connection, see page 21.

AC IN inlet
Use this inlet to plug in the supplied power cable.
See page 20 for connection information.



OPTICAL  COAXIAL
DIGITAL OUT

Transport

4) Foot

The feet of this unit include built-in spikes. Using the
spikes can reduce the effect of vibrations on the set.
When using the spikes, remove the transport tape, then
remove the magnet foot by pulling it.

» (?TSpike
tape @—Magnet

foot
&

When using the feet’s built-in spikes, the spikes may scratch
the shelf or floor on which this unit is installed. Use the
magnet feet or appropriate supports when placing this unit on
expensive furniture, etc.

Mo

N
If this unit is unstable, you can adjust the foot height by
rotating it.
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H Remote control
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@ Infrared signal transmitter

Sends infrared signals to this unit.

@ (O CD key

Turns this unit ON or switches it to STANDBY mode.
For details on STANDBY, see “Front panel” (page 6).
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(® 4 OPEN/CLOSE key
Opens or closes the disc tray.

@ () AMP key

Turns the Yamaha amplifier ON or switches it to
STANDBY mode.

Note

Some Yamaha amplifiers cannot be controlled with the
() AMP key of this remote control.

DIMMER key

Selects the brightness level for the front panel display.
Each time you press the DIMMER key, the brightness
level changes in the following order:

I—;Max (brightest)—» Level 1 (default)
Level 3 (darkest) «—— Level 2

My,

So
This setting is retained even if you turn off this unit.

Numeric buttons
Use to select a track directly.

Note

This operation is ineffective for MP3 or WMA discs.
REPEAT key

Repeats playback of a single track or all tracks. Each

time you press the REPEAT key during playback, the
repeat playback mode changes as follows:

v
REPEAT OFF (repeat playback off): Repeat
playback is cancelled.

|
REP S (single repeat playback): On reaching
the end of the current track, playback repeats
from the beginning of the current track.

v
REP ALL (all repeat playback): On reaching
the end of the last track, playback repeats from
the beginning of the first track.

Note
This operation is ineffective for MP3 or WMA discs.
PROGRAM key

Turns on or off the program playback mode. See
“Program playback” (page 14).



SHUFFLE key

Plays tracks on the disc in random order (shuffle
playback).

Notes

« This operation is ineffective for MP3 or WMA discs.
« The shuffle playback mode is cancelled when playback is
stopped or the disc is ejected.

<1 (Search backward) key

== (Search forward) key
Searches tracks backward/forward.

00 (Pause) key
Pauses playback. Press the = or 00 key to resume
playback.

=> (Play) key
Starts playback.

=<1 (Skip backward) key

Press the key once to skip back to the beginning of the
current track.

Press it twice to skip to the beginning of the previous
track.

= (Skip forward) key
Press the key once to skip to the next track.

= (Stop) key
Stops playback.
SOURCE key

Selects the audio source to be played back. Each time
you press this key, the audio source is switched.

DISC USB
(SA-CD/CD)
COAXIAL OPTICAL «—

(coaxial digital input) (optical digital input)

R

The audio source setting is retained even if you turn off this
unit.

PURE DIRECT key

Turns on the PURE DIRECT mode to improve audio

quality.

When this unit is in the PURE DIRECT mode:

» The PURE DIRECT indicator lights.

* No signal is output from the DIGITAL OUT
(OPTICAL and COAXIAL) jacks on the rear panel
(page 10).

+ The least indicators and messages appear on the
front panel display.

N A

« Press this key again to turn off the PURE DIRECT mode.
« This setting is retained even if you turn off this unit.

DISPLAY key

Switches the time display. Each time you press the
DISPLAY key during playback, the time display
changes as follows:

TRACK: Elapsed time of the current track

TRACK REMAIN: Remaining time of the
current track

TOTAL REMAIN: Total remaining time of the
disc

ENTER key
Confirms a track number entered when you are
programming tracks.

CLEAR key

Erases the last programmed track when this unit is in
the program editing mode. See “Program playback”
(page 14).

Soe

To erase all programmed tracks, press the CLEAR key while
programmed playback is stopped.

LAYER key

Switches the playback layer of a hybrid Super Audio
CD between SA-CD and CD while playback is
stopped (page 27).

¢

This setting is retained even if you turn off this unit.

Note

When SA-CD layer is selected, audio signals are output only
from the BALANCED OUT and ANALOG OUT jacks.

Yamaha amplifier operation keys

Operates the Yamaha amplifier.

Refer to the owner’s manual of your amplifier for
details.

Note

Some Yamaha amplifiers cannot be controlled with the keys
of this remote control.

See page 28 for more information on MP3/WMA
playback.
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B Program playback
In the program playback mode, you can play back tracks
in a programmed sequence.

Notes

« This operation is ineffective for MP3 or WMA discs.
» The programmed tracks are erased in the following cases:
—when the disc is ejected
— when this unit is turned off or goes to STANDBY mode
—when an audio source other than the disc is selected
—when the playback layer of a hybrid Super Audio CD is
switched between SA-CD and CD

1 Press PROGRAM while playback is stopped.

This unit is set to the program editing mode.

2 Select a track by using the numeric buttons
and press ENTER.

3 Repeat step 2 to program the next track.
You can program up to 24 tracks.

4 Press the = (Play) key.
Playback starts from the beginning of the
programmed sequence.
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B Setting the DPLL (Digital Phased Lock
Loop) bandwidth
The audio DAC (ES9018) of this unit employs DPLL to
generate accurate clock signals synchronized with the
clock of the input digital audio signal. The 7-step DPLL
bandwidth setting gives the unit tolerance for fluctuation
of the clock of the input digital signal and adjustment of
the accuracy of the operating clock in the DAC.

1 Press SOURCE to select the audio source to
be played back.
The DPLL bandwidth can be set for each audio
source, respectively.

2 Within 5 seconds after selecting the audio
source, press ENTER.
The unit enters the setting mode, and the DPLL
bandwidth currently set appears on the information
display.

3 Select the DPLL bandwidth using the o0
(pause) key and the = (stop) key.
Each time the 00 (pause) key is pressed, the
bandwidth changes in the following order. If you
press the 3 (stop) key, it changes in reverse order.

— Lowest

Low

!

Med-Low (default)

Medium

!

Med-Hi

High
J

— Highest




Press ENTER.

The setting value flashes for 3 seconds, then the unit
resumes to normal mode.

To cancel the setting, press CLEAR.

Notes

* As the DPLL bandwidth setting value approaches “Lowest,” the
accuracy of the operating clock in the DAC improves, but the
unit may be susceptible to a change in the clock of the external
component. The sound from such a component may more easily
skips.

 As the DPLL bandwidth setting value approaches “Highest,”
the accuracy of the operating clock in the DAC deteriorates, but
the unit is far less susceptible to a change in the clock of the
external component, and the sound from such a component
hardly skips.

B Setting the AUTO POWER STANDBY
function

The AUTO POWER STANDBY function can be set to
ON or OFF. When set to ON, if the unit is not operated for
30 minutes with no audio signal detected, it automatically
goes to STANDBY mode. When set to OFF, the unit does
not go to STANDBY mode automatically.

1

Open the disc tray and remove any currently-
loaded disc from the unit.

Skip step 1 to 3 if “NO DISC” appears on the
information display.

Close the disc tray.

Press SOURCE to select “DISC” as the audio
source.
“NO DISC” appears on the information display.

Press and hold the = (Stop) key or = (Play)

key on the front panel for about 2 seconds to

switch the setting.

I (Stop) key: The AUTO POWER STANDBY
function switches to ON, and
“AutoSTBY ON” appears on the
information display.

> (Play) key: The AUTO POWER STANDBY
function switches to OFF, and
“AutoSTBY OFF” appears on the
information display.

Notes

« The default setting for the AUTO POWER STANDBY function

is ON.

« This setting is retained even if you turn off this unit.
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B Installing batteries in the remote control

Remove the battery compartment cover.

2 Insert the two batteries (AAA, R03, UM-4)
according to the polarity markings (+ and -)
on the inside of the battery compartment.
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Connections

In this section, you will make connections between CD-S3000 and your amplifier.




If your amplifier is equipped with XLR
balanced input jacks,

we recommend balanced connection
for optimum audio performance.

When the SA-CD layer is played, the
audio signals are output only from the
BALANCED OUT and ANALOG OUT
jacks.

® ® ©

BALANCED OUT ANALOG OUT

BALANCED OUT

+HOT

-CcoLD

SYSTEM CONNECTOR

aren--

9]qed paduejeq X

/

N0
oocooo J00 O
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digital output (PCM) jack

Note

Only PCM signals can be input to the DIGITAL IN
(OPTICAL/COAXIAL) jacks of this unit. For details on

the supported PCM signals, see page 26.

usB OPTICAL COAXIAL OPTICAL COAXIAL
DIGITAL IN DIGITAL OUT
J/
(e} o
S 3 o
= [
w [ X,
I o o 2 g
g 2 8 2 2
® o X a a
3 2 g g g
< o o o =
© I3 = o
o = Q z >
o ) 8 o )
Q Q
D
4 T
© )
(0)8 o
EEEEEESEES: Do () @ @
[ —
: ' = =  — 7 —J
PC Component equipped with a AV receiver equipped with a

digital input jack
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B Connecting to the BALANCED OUT B Connecting the power cable

jacks Plug the power cable into the AC IN inlet when all
Connect your amplifier with the XLR balanced input connections are complete, and then plug in the power
jacks. The pin assignments for these jacks are shown cable to the AC outlet.
below. Refer to the owner’s manual supplied with your
amplifier and verify that its XLR balanced input jacks are — (©
compatible with the pin assignments. U

usB OPTICAL  COAXIAL OPTICAL

A

ACIN

DIGITAL IN DIGIn

3: cold
When connecting, be sure to match the pins and insert the Rear panel of CD-S3000
connector of the “female” XLR balanced cable. When
disconnecting, pull out the “female” XLR balanced cable
while pressing down the latch lock on the plug.

Supplied power cable

“Female” XLR connector

“Male” XLR connector

to an AC outlet
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B Operating this unit from another room
If you connect an infrared receiver and transmitter to the
REMOTE IN/OUT jacks of this unit, you can operate the
unit and/or external component using the supplied remote
control located in another room.

Rear panel of CD-S3000

SYSTEM CONNECTOR REMOTE
o IN out ( N\
(7N 0 0
Ole g [
| ] 1 ACIN
=N g
Infrared Infrared
receiver transmitter

Remote control

External component
(e.g. Amplifier)

H Remote connection between Yamaha

components
When you have another Yamaha component supporting
remote connection, as this unit does, an infrared
transmitter is not necessary. You can transmit remote
signals by connecting an infrared receiver and the
REMOTE IN jack of the other component to the
REMOTE IN/OUT jacks of this unit, using cables with
monaural miniplugs.
Up to three Yamaha components (including this unit) can
be connected.

Rear panel of CD-S3000

SYSTEM CONNECTOR REMOTE

- IN ouT
(/Qv\) @ @ 0 DW
\e L

2

Infrared
receiver
[ o
BO Ce=Cm—

S
[ )

Yamaha component
(up to three components
including this unit)

Remote control
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When a PC is connected to the USB jack of this unit, the
unit functions as a USB DAC, enabling music files stored
on the PC to be played via an amplifier connected to the
unit.

Rear panel of CD-S3000

@

BALANCED OUT *

COAXIAL
DIGITAL IN

USB cable (Type B)

B Supported operating systems
The USB connection with this unit is for PCs with the
following operating systems:
Windows: Windows Vista (SP2, 32bit/64bit)/
Windows 7 (32bit/64bit)/
Windows 8 (32bit/64bit)

Mac: OS X 10.5.8/10.6.8/10.7.x/10.8.x

Notes

« Operations with other operating systems are not guaranteed.

« Operations may be disabled even with the above-mentioned
operating systems, depending on the configuration or
environment of the PC.

« Operations may not be executed correctly if the PC is connected
to this unit before the driver is installed.
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B Installing the dedicated driver
Before connecting a PC to this unit, install the dedicated
driver on the PC.

1 Accessthe following URL, download the
dedicated “Yamaha Steinberg USB Driver,’
then extract and execute the file.

Website for downloading the exclusive driver
URL: http://download.yamaha.com/

2 Install the downloaded “Yamaha Steinberg
USB Driver” on the PC.
For details, refer to the Installation Guide supplied
with the downloaded driver.

3 When installation is complete, quit all
running applications.

4 set the audio output destination of the
computer to “Yamaha CD Player.”

With Windows OS:

Control Panel — Sound — [Playback] tab
With Mac OS:

System Preferences — Sound — [Output] tab

The setting may vary, depending on the operating
system. For details, consult the manufacturer of your
PC.

Mo

NoA
Transmittable sampling frequencies are as follows:
44.1 kHz/48 kHz/88.2 kHz/96 kHz/176.4 kHz/192 kHz

Notes

 Operations may not be executed correctly if the PC is connected
to this unit before the driver is installed.

* When the driver is installed on a Windows XP computer, the
operation speed of the computer may be reduced. In such a case,
restart the computer.

« The “Yamaha Steinberg USB Driver” is subject to change
without prior notice. For details and the latest information, refer
to the download page for the driver.



Playing back music files stored on the
PC

Connect the PC to this unit, using a USB
cable.

Turn on the PC.

Turn this unit on by pressing the STANDBY/
ON/OFF switch on the front panel.

Select “USB,”’ using the SOURCE key of this
unit.

Set the audio output destination of the PC to
“Yamaha CD Player.”

With Windows OS:

Control Panel — Sound — [Playback] tab
With Mac OS:

System Preferences — Sound — [Output] tab

The setting may vary, depending on the operating
system. For details, consult the manufacturer of your
PC.

Operate the PC to start playback of music
files.

When the music signal is fed from the PC to the unit,
the sampling frequency of the file being played is
indicated on the display of the unit.

B Adjusting the sound volume

To obtain higher sound quality, set the sound volume at
the PC to the maximum, and gradually increase the
volume at the amplifier from the minimum to your desired
level.

Notes

Do not disconnect the USB cable, turn off the unit, or change
the input with the SOURCE key while playback on a PC
connected via the USB cable is in progress. Doing so may cause
a malfunction.

« To mute operation sounds of the PC during music playback,
change the setting on the PC.

« If music files cannot be played correctly, restart the computer
and perform the mentioned procedure again.

* The music files stored on a PC cannot be controlled from this
unit or the remote control of this unit. Operate them on the PC.
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Specifications

In this section, you will find technical specifications for CD-S3000.




AUDIO SECTION
« Frequency Response (1 kHz, 0 dB)

SA-CD .o 2 Hz to 50 kHz (-3 dB)
CD it 2 Hzto 20 kHz
« Playback Frequency Range 2 Hz to 96 kHz
« Harmonic Distortion (1 kHz, 0 dB)
SA-CD oottt 0.002% or less
CD o 0.002% or less
« Signal to Noise Ratio (IHF-A Network) (1 kHz, 0 dB)
SA-CD/CD ............ 116 dB or more
« Dynamic Range (1 kHz, 0 dB)
SA-CD ottt 110 dB or more
CD it .. 100 dB or more
« Output Level (1 kHz, 0 dB)
SA-CD/CD ..ottt 20£03V
LASER DIODE PROPERTIES
« Wavelength
SA-CD 655 nm
CD s 790 nm
* Output Power
SA-CD 1.89 mW (max)
CD oo .. 1.36 mW (max)
INPUT/OUTPUT SECTION
« Digital Input (DIGITAL IN)
USB (Type B) x 1 USB 2.0 compliant
OPTICAL x 1
COAXIAL x 1
Support audio sample rate ......... 44.1/48/88.2/96/176.4/192 kHz
Word depths ........coovecuiieiiiieiniccceeeccceeeeae 16 bit/24 bit
« Digital Output (DIGITAL OUT)
OPTICAL x 1
COAXIAL x 1
Support audio sample rate ......... 44.1/48/88.2/96/176.4/192 kHz
Word depths ....c.c.ceevecueieueinieiriccceneereccieereeae 16 bit/24 bit
 Audio Output
ANALOG OUT ..ot Unbalanced x 2 ch (L/R)
BALANCED OUT ...ccceooviieineieeene Balanced x 2 ch (L/R)
* Remote Input/Output
REMOTE IN
REMOTE OUT

« System Connector
SYSTEM CONNECTOR

26 £n

GENERAL

« Power Supply
[China, Korea, Asia, Australia, U.K. and Europe models]
... AC220-240V, 50/60 Hz

[U.S.A, Canada and Taiwan models]
.. AC110-120V, 50/60 Hz

« Power Consumption ...........c..ccc..... 30 W
« Standby Power Consumption (reference data) ...........cccceeuenee. 03W
* Dimensions (W X HX D) ...cccccoovvivnvneeennnes 435 x 142 x 440 mm

(17-1/8” x 5-5/8” x 17-3/8”)
o Weight oo 19.2 kg (42.3 Ibs)

* Specifications are subject to change without notice.

Taking care of this unit

Polish finish on the side panels

Use of Yamaha Unicon cloth (sold separately) is
recommended. For heavy dirt, use Yamaha Piano
Unicon (sold separately). For puschasing, contact your
nearest authorized Yamaha dealer or service center.
Other finish

When you wipe this unit, do not use chemical solvents
(alcohol, thinner, etc.), which might damage the finish.
Use a clean, dry cloth. For heavy dirt, dampen a soft
cloth in detergent diluted with water, wring it out, and
clean this unit with the cloth.




B Supported disc types
This unit is designed to play back compact discs bearing
the marks shown below. Never attempt to load any other

types of discs into this unit. This unit can also play back 8-

cm (3-inch) compact discs.

Super Audio CD

H

SUPER AUDIO CD
Audio format based upon the current CD standards but
includes a greater amount of information that provides

higher quality sound. There are three types of discs: single

layer, dual layer and hybrid discs. The hybrid disc can be

played on existing CD players as well as Super Audio CD

players since it contains both standard audio CD and
Super Audio CD information.

Note

This unit does not show text data on the front panel display.

Compact discs (digital audio)
COMPACT

DIGITAL AUDIO

The most popular discs for commercially available audio
CDs.

CD-R, CD-RW digital audio discs

iee oise olEe oise

DIGITAL AUDIO | DIGITAL AUDIO i
Recordable ReWritable) BeWWritable
Music CDs made by copying onto a CD-R or CD-RW

(including MP3 or WMA format files).

Notes

 Be sure to use a CD-R or CD-RW disc made by a reliable
manufacturer.

« Be sure to use a CD-R or CD-RW disc which has at least one of

the following phrases on the disc or disc case.
— FOR CONSUMER
— FOR CONSUMER USE
— FOR MUSIC USE ONLY
* Be sure to use a finalized CD-R or CD-RW disc.

CD-TEXT discs

lISE

DIGITAL AUDIO

The discs recorded with text data such as album titles,
track titles, and artist names. These discs can be played
back with ordinary CD players.

Note

This unit does not show text data on the front panel display.

NOTE:
This unit may not be able to play back some CD-RW discs or
discs on which recording was not made correctly.

To prevent a malfunction of this unit:
* Do not use any nonstandard shaped

disc (heart, etc.) available in the

market as it might damage this unit.
* Do not use a disc with tape, seals, or

paste on it. Such a disc may get stuck

in this unit or cause damage to this

unit.
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B About MP3 and WMA discs
You can play back MP3 and WMA files recorded on a
CD-R or CD-RW with similar uses as a music CD.

MP3

MP3 (MPEG-1 Audio Layer-3) is a standard technology
and format for compressing an audio sequence into a
small-sized file. However, the original level of sound
quality is preserved during playback.

Notes

« This unit plays back MP3 files in alphanumeric order.

« Up to 648 folders and files (combined) and up to 299 folders are
recognized; however, some folders and files may not be
recognized depending on their directory structure.

* Depending on recording conditions such as recording software
settings, this unit may not be able to play back the disc or files
in the order they were recorded.

« This unit is compatible with a sampling frequency of 44.1 kHz.

« This unit is compatible with a bitrate of 32, 40, 48, 56, 64, 80,
96, 112, 128, 160, 192, 224, 256, or 320 kbps. Variable bitrate is
not supported.

« The disc must be ISO9660 compatible.

 The text data contained in the files are not displayed on this
unit.

WMA

WMA (Windows Media Audio) is a Microsoft file format
for encoding digital audio files similar to MP3 although
WMA can compress files at a higher rate than MP3.

Notes

« This unit plays back WMA files in alphanumeric order.

« Up to 648 folders and files (combined) and up to 299 folders are
recognized; however, some folders and files may not be
recognized depending on their directory structure.

« This unit is compatible with a sampling frequency of 44.1 kHz.

« This unit is compatible with a bitrate of 48, 64, 80, 96, 128, 160,
or 192 kbps. Variable bitrate is not supported.

* The disc must be ISO9660 compatible.

« Copyright-protected WMA files cannot be played back with
this unit.

« The text data contained in the files are not displayed on this
unit.
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B Handling compact discs

Always handle a disc with care so that its surface is not
scratched.

Compact discs are rarely worn out during playback, but
damage to the disc surface when the disc is being
handled can adversely affect the disc playback.

Be sure to use a felt-tip pen or similar writing tool
when writing on the label side of a disc. Do not use a
ball-point pen, pencil, or other hard-tipped writing
tools as these may damage the disc and may adversely
affect the disc playback.

Do not warp discs.

‘When a disc is not currently being used, remove it from
this unit and store it in an appropriate case.

When removing or storing a disc, be careful not to
scratch the playing surface.

Compact discs are not affected by small particles of
dust or fingerprints on their playing surface, but even
so they must be kept clean. Wipe the disc surface with
a clean, cry cloth. Do not wipe the disc surface with a
circular motion; wipe it straight outward from the
center.

Do not try to clean the disc surface with any type of
disc cleaner, record spray, anti-static spray or liquid, or
any other chemical-based liquid as such substances
may irreparably damage the disc surface.

Do not expose discs to direct sunlight, high
temperature, or high humidity for a long period of time
as these conditions may warp or otherwise damage the
disc.

= ',
= —

To play back an 8-cm (3-inch) compact disc, place it in
the inner recessed area of the disc tray. Do not put a
normal 12-cm CD on top of an 8-cm CD.



Refer to the chart below if this unit does not function properly. If the problem you are experiencing is not listed below or
if the instructions below do not help, turn off this unit, disconnect the power cable, and contact the nearest authorized
Yamaha dealer or service center.

ee
Problem Cause Remedy S
page
The unit does not The power cable is not connected nor completely | Securely connect the power cable.
switch ON when connected. 20
STANDBY/ON/OFF is
pressed upward.
This unit The automatic standby function is activated. If the unit is not operated for 30 minutes with no
automatically goes to audio signal detected, it automatically goes to 6
STANDBY mode. STANDBY mode.
The disc tray does not | A foreign object is obstructing the tray. Carefully check the disc tray and remove the .
close completely. foreign object.
Playback does not The disc is damaged. Check the disc carefully; replace it if necessary. —
start.
There is moisture on the laser pickup. Wait 20 to 30 minutes after switching the unit .
ON before trying to play back a disc.
The disc is loaded upside down. Reload the disc with the label side up. —
The disc is dirty. Clean the disc. 28
The MP3 or WMA formats are not compatible Replace the disc with a correctly recorded disc 8
with this unit. playable with this unit.
The CD-RW (ReWritable) disc is not recorded Replace the disc with a correctly recorded disc 27
correctly. playable with this unit.
The disc is a non-standard disc not playable with | Replace the disc with a correctly recorded disc 27
this unit. playable with this unit.
Playback is delayed, The disc may be scratched or damaged. Check the disc carefully; replace it if necessary.
or begins at the 28
wrong place.
No sound. Improper output cable connections. Connect the cables properly. If the problem 18
persists, the cables may be defective.
Improper amplifier operation. Set the amplifier controls to the correct input o
selection.
No playback sound The unit is in PURE DIRECT mode. Turn off PURE DIRECT mode. 7
from the component
connected to the The Super Audio CD layer is being played. Change the layer for playback. 7
digital input jacks.
Sound “skips.” This unit is being subjected to vibrations or Relocate this unit. o
impacts.
The disc is dirty. Clean the disc. 28
The clock of the playback audio signal is Change the DPLL bandwidth of the audio DAC 14
fluctuated. (ES9018).
Sound “hums.” Improper cable connections. Securely connect the audio cables. If the problem 13
persists, the cables may be defective.
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See

has not been installed correctly.

again, following the correct procedure.

Problem Cause Remedy
page
Noise from a nearby The tuner is too close to this unit. Move the tuner and this unit farther apart. o
tuner.
Noise from inside of The disc may be warped. Replace the disc. 28
the disc tray.
No sound from the The output audio source setting on the connected | Only PCM audio sources can be played via the
component component is not “PCM.” DIGITAL IN (OPTICAL/COAXIAL) jacks of
connected to the this unit. —
DIGITAL IN (OPTICAL Set the output audio source of the connected
or COAXIAL) jack. component to “PCM.”
The remote control The batteries of the remote control are too weak. | Replace the batteries with new ones. 16
does not work.
Remote control is too far away or tilted too Use within 6 m and 60° radius. 9
much.
Direct sunlight or lighting (of an inverter type Reposition this unit.
fluorescent lamp etc.) is striking the remote 9
control sensor of this unit.
H On USB connection
Problem Cause Remedy See
page
The connected PC The operating system of the PC is not supported. | Use a PC with an operation-guaranteed operating 9
does not recognize system.
this unit. -
Improper USB cable connection Connect the USB cable properly. 19,22
The output of the PC or application is muted. Cancel the sound muting of the PC or o
application.
Noisy playback. Another application is launched on the PC while | If another application is launched while a music
a music file is being played. file is being played, sound may be momentarily
lost or noise may be generated. —
Do not launch other applications during
playback.
Music files cannot be | The music data are not properly reproduced, Connect this unit to the PC and set the input of
played. because this unit is connected to the PC or the the unit to “USB” in advance. Then launch the 3
input of this unit is switched to “USB” while the | music application and start playback.
music application is running on the PC.
The dedicated “Yamaha Steinberg USB Driver” | Install the “Yamaha Steinberg USB Driver” 2
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B Messages on the information display

Message Status
NO DISC No disc is set on the disc tray.
Check Cable The dedicated “Yamaha Steinberg USB Driver” has not been installed correctly. Or, the audio output
of the computer has not been set to “Yamaha CD Player.”
Check PC The audio signal from the computer cannot be recognized.
Fs: ----kHz No audio signal is recognized.
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Reference Information

Playing back DSD audio using foobar2000

Contents
NOTICE.......ccciictrimrrsmsrsmrssmssssnsssmssssssssasssnsassassssssssmssassessnsssassasmsssnssasmnssnssssnnnsn
Required components ....

Installing foobar2000 .........ccueeriisemmmissssmissnsmssmsnssssssses s sssssasassssssmsssssnns
Installing Yamaha Steinberg USB Driver and configuring its settings...... 2

Installing the “ASIO support” component .........cccoecemrrrnssssmnresssssssressssssens 3
Installing the “Super Audio CD Decoder” component .........cccuumerrssansssanns 5
Configuring DSD playback settings of foobar2000...........cccucecerssmnrrasnnnnes 7

NOTICE

e “foobar2000” is not Yamaha product. Yamaha cannot be held responsible for any damages arising out of the use of the software.
e “foobar2000” is installable only on Windows computers. The procedures described in this documentation are based on Windows 7.
e The documentation is based on information as at May 2013 (We have no plans to offer updates).

Required components

foobar2000

“foobar2000” is an advanced freeware audio player for Windows. By installing foobar2000 and other components on your Windows
computer, you can enjoy DSD (Direct Stream Digital) audio playback on the unit (via USB DAC).

Yamaha Steinberg USB Driver
Driver software required for connecting a device compatible with Yamaha Steinberg USB Driver to a computer.

ASIO support
A component required for DSD audio playback on foobar2000.

Super Audio CD Decoder
A decoder required for direct DSD playback of Super Audio CD ISO images, DSDIFF and DSF files on compatible devices.

Playing back DSD audio using foobar2000 a



Installing foobar2000

1 Download the latest stable version of foobar2000 at the following website.
http://www.foobar2000.org/download

2 Double-click the downloaded file “foobar2000_v*.*.*.exe” to start installation.

3 Follow the on-screen instructions to install the software.

Installing Yamaha Steinberg USB Driver and

configuring its settings

1 Download “Yamaha Steinberg USB Driver” at the
following Yamaha website.

http://download.yamaha.com/

2 Install “Yamaha Steinberg USB Driver” on your
computer, connect the unit to your computer,
then open its control panel.

For details on the installation and how to open the
control panel of the driver, refer to the Installation Guide
supplied with the driver software.

For details on the connection, refer to the Owner’s
Manual of the unit.

3 Configure the following control panel settings.

* “ASIO” setting &4 Yamaha Steinberg USE Driver =]

Device: Yamaha CD player .
play Yamaha CD Player ASIO |Ab0ut|

Device : IYamaha CD Player j
Buffer Size : |1310?2 Samples 'I
Input Latency : 50.437 msec
Output Latency : 54.439 msec

0K | Cancell

e “Yamaha CD Player” setting &4 Yamaha Steinberg USB Driver (23]

Sample Rate: 176.4 kHz Yamaha CD Player |ASIO | About |

Sample Rate : 176.4 kHz A

Cancel |

4 ciick [OK].
Installation and settings of “Yamaha Steinberg USB
Driver” is now completed.
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Installing the “ASIO0 support” component

'l Download the “ASIO support” component
(foo_out_asio) at the following website.

http://www.foobar2000.org/components/view/
foo_out_asio

2 Run foobar2000, then select [File] > . foobar2000 v

[Preferences]_ File | fdit View Playback Library Help | [] [> [ K B [ —)
Open... Ctrl+0
Bpes R Trackno Title / track artist Durat...
Add files...
Add folder..
Add location... CtrlsU
New playlist Ctrl+N
Load playlist...
Save playlist... CtrleS
o+
Exit

] . ‘ - \
3 Click [Components] - [Install]. Preferences: Components e
Companents lled Right-click a component for additional options
p—r Name = Version Modue
e Abum List 45 foo_albumist
Networking CD Audio Decoder 3.0 foo_cdda
- -Playback Converter 15 foo_converter
Shel Integration Default User Interface 0.9.5 foo_ui_std
- Advanced Equalizer 1.0 foo_dsp_eq
foobar2000 core 126 Core
ReplayGain Scanner 2.2 foo_rgscan
Standard DSP Array 12 foo_dsp_std
Standard Input Array 10 foo_input_std
Get more components
Why are some components arayed out? l Instal... .MJ Get updates
S— ;J
Resetall Reset page oK Cancel Apply
L
Name Date modified Type Size
4 Select the downloaded component
« . p ”» . I‘ﬁ'foo,out,as\o.fblkrcomponentl 2013/05/15 14:42 foobar2000 Comp... 183KB
foo_out_asio.fb2k-component”, then click
[Open].
1me: foo_out_asio.fb2k-component -
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5 ciick [Apply].

6 In the dialog box, click [OK] to restart
foolbar2000.

7 I foolbar2000 is restarted, click [File] >
[Preferences] > [Components], then confirm
“ASIO support” is listed in “Installed
components”.

Installation of the “ASIO support” component is now
completed.

Preferences: Components

e

Components
> -Display
Keyboard Shortauts
b -Media Library
Networking
> -Playback
Shell Integration
- Advanced

lled Right-cick a component for additional options.
Name Version Module
Album List 45 foo_albumlist
CD Audio Decoder 3.0 foo_cdda
Converter 15 foo_converter
Default User Interface 095 foo_ui std
Equalizer 10 foo_dsp_eq
foobar 2000 core 126 core
ReplayGain Scaner 2.2 foo_rgscan
Standard DSP Array 12 foo_dsp_std
Standard Input Array 1.0 foo_input_std
(unknown - please apply changes toload) (unknown) _foo_out_asio

Get more components
Why are some components araved out?

Resetall | | Resetpage

oK concel ) [ apoiy

Copyreport | |Get updates

s

foobar2000 preferences

S=X)

Applying these changes requires foebar2000 to be restarted. Continue?

oK Cancel

Preferences: Components

e

Components
> -Display
Keyboard Shortauts
b -Media Library
Networking
> -Playback
Shell Integration
- Advanced

lled Right-ciick a component for additional options.
Name B Version Module
FTRPTY o PR
ASIO support 212 foo_out_asio
Converter 15 foo_converter
Default User Interface 0.5 foo_ui std
Equalizer 10 foo_dsp_eq
foobar2000 core 126 core
ReplayGain Scanner 22 foo_rgscan
Standard DSP Array 12 foo_dsp_std
Standard Input Array 10 foo_input_std

Get more components
Why are some components araved out?

Resetall | | Resetpage
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Installing the “Super Audio CD Decoder” component

II Download the latest version of “foo_input_sacd- Loaking for the latest version? Download foo_input_sacd.0.6.4.zip (442.2 kB)
0.*.*.zip” at the following website. Homs ! foo_input. sacd 5
http://sourceforge.net/projects/sacddecoder/ Name # Modified ¢ Size ¢ Downloads ¢
files/foo_input_sacd/ © Premilis
Ifnn_input_sacd-D 6.4zip [i}] ] I
foo_input_sacd-0.6.3 zip ]
foo_input_sacd-0.6.2.zip 0
foo_input_sacd-0.6.1.zip ]
foo_input_sacd-0.6.0 zip 0
foo_input_sacd-0.5.11.zip 0
2 Uncompress the downloaded file
“foo_input_sacd-0.*.*.zip”.
3 In the uncompressed folder, double-click . filters
“ASIOProxylnstall-0.*.*.exe” to start installation.
| EIC
7] ASIOProxylnstall-0.6.3.exe
|%| foo_input_sacd.dll
|| readme.td
4 Follow the on-screen instructions to install the
component.
5 Run foobar2000, then select [File] > [Preferences]. 2 fo0bar2000 v
File | [Edit View Playback Library Help O 0mKHE —)
Open... Ctrl+0
Open audie CD... Track no Title / track artist Durat...
Add files...
Add folder...
Add location... Ctrl+U
New playlist Ctrl+N
Load playlist...
Save playlist... Ctrl+§
Exit
6 click [Components] > [Install]. Prferences Componerts B
I Components I Installed components: Right-click a component for additional options
Name . Version Module
- :Z:?:E:f:'ﬁ”“ Album List 45 foo_albumist
Networking ASIO support 212 foo_out_asio
> -Playback CD Audio Decoder 3.0 foo_cdda
Shell Integration Converter 15 foo_converter
Advanced Default User Interface 0.9.5 foo_ui_std
Equalizer 1.0 foo_dsp_eq
foobar 2000 core 1.2.6 Core
ReplayGain Scanner 2.2 foo_rgscan
Standard DSP Array 12 foo_dsp_std
Standard Input Array 0 foo_input_std
E%ﬁ%@m l Install... Copy report | | Get updates
S—
Resetall Reset page oK Cancel Apply
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7 Select the downloaded component
“foo_input_sacd-0.*.*.zip”, then click [Open].

8 click [Apply].

9 In the dialog box, click [OK] to restart
foolbar2000.

1 O If foolbar2000 is restarted, click [File] >
[Preferences] > [Components], then confirm
“Super Audio CD Decoder” is listed in “Installed
components”.

Installation of the “Super Audio CD Decoder”
component is now completed.

Name

Date modified Type

Size

N fooinput sacd-054.ip ||

2013/05/15 14:51

Compressed (zipp... [

32 KB

me: foo_input_sacd-06.4.zip

~ | foobar2000 components (fo
n Cancel

Preferences: Components

e

Components
> -Display
Keyboard Shortauts
b -Media Library
Networking
> -Playback
Shell Integration
- Advanced

lled Right-cick a component for additional options.
Name Version Module
Album List 45 foo_albumlist
ASIO support 212 foo_out_asio
CD Audio Decoder 3.0 foo_cdda
Converter 15 foo_converter
Default User Interface 0.5 foo_ui std
Equalizer 10 foo_dsp_eq
foobar2000 core 126 Core
ReplayGain Seanner 22 foo_rascan
Standard DEP Array 12 foo_dsp_std
Standard Input Array 10 foo_input_std
(unknown - please apply changes toload) (unknown) _foo_input_sacd

Get more camponents
Why are some components araved out?

Resetall | | Resetpage

oK concel [ apoiy

Copyreport | |Get updates
pr—

-

foobar2000 preferences

X

Applying these changes requires foobar2000 to be restarted. Continue?

oK Cancel

Preferences: Components

e

Components
-Display

Keyboard Shortauts
b -Media Library
Networking
-Playback

Shell Integration
-Tools

Advanced

lled Right-cick a component for additional options.

Name B Version Medule
Album List 45 foo_albumlist
ASIO support 212 foo_out_asio
CD Audio Decoder 3.0 foo_cdda
Converter L5 foo_converter
Default User Interface 0.5 foo_ui std
Equalizer 10 foo_dsp_eq
foobar2000 core 126 core
ReplayGain Scanner 22 foo_rgscan
Standard DSP Array 12 foo_dsp_std

T . PR
Super Audio CD Decoder 0.6.4 foo_input_sacd | |

Get more components
Why are some components araved out?

Resetall | | Resetpage
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Configuring DSD playback settings of foobar2000

1 Click [File] > [Preferences] - [Playback] >
[Output], then select “ASIO:foo_dsd_asio” from
the “Device” pull-down list.

2 Ciick [Output] > [ASIO], then double-click
“foo_dsd_asio” in “ASIO drivers”.

3 Configure the following settings.
ASIO Driver: Yamaha Steinberg USB ASIO
DSD Playback Method: ASIO Native

Fs: DSD64 (normal speed playback) or DSD128
(double speed playback)

4 Click [X] (close button) to close the window.

5 Click [Tools] > [SACD], configure the following
setting.
ASIO Driver Mode: DSD

6 click [OK].

DSD playback settings of foobar2000 is now
completed.

You are ready to enjoy DSD audio playback on the unit.

-
Preferences: Output

~Components

> -Display
~Keyboard Shortcuts
> -Media Library

> Quiput
BT Itegrs ton
» -Tools

- Advanced

Device

[ps 2 Primary Sound Driver

[ASIO : foo dsd_asio

DS : Primary Sound Driver

DS : Realtek Digital Output{Optical) (Realtek High Definition Audio)
DS : Realtek Digital Output (Realtek Hgh Definition Audio)

DS : Realtek Digital Output {Realtek High Definition Audio)

W/arning; setting too law buffer length may cause some visuslization effects to stop working.

‘Output format

Output data Format Dither

Output data format will be chosen automatically for the selected device,

Fading
Name Fade in Fade out
Pause and stop 100ms 100 ms
Seek 100ms 100 ms
Marual track change 100 ms 100 ms
Automatic track change oms oms

Fade in:

i
i

Resetall Reset page

Fade out:

Apply

-
Preferences: ASIO

> -Display
Keyboard Shortauts
» -Media Library
Networking
4 -Playback
- DSP Manager

4-Tools
t.5ACD
Advanced

Components

ASIO drivers

Iﬁo dd 3o i

Double ick an entry to actvate the driver's control panel.
[7]Use 64-bit ASIO drivers
[C1Run with high process priarity

‘Custom channel

Add New

This feature allews you to configure alternate channel mappings for your ASIO-enabled
soundeards.

‘fou may need to dose and re-open the foobar2000 preferences dialog for your newly
‘added mappings to appear as output devices in the “output” page.

F

foo_ds=d_asio v0.6.3

===

ASIO Driver:

DSD Playback Method:

'Yamaha Steinberg USE ASIO -
=

|10 Native

PCM to DSD Method:

INone LI

Fs: |DsD128 v |

Preferences: SACD

Campanents
> -Display
Keyboard Shortauts
b -Media Library
Networking
4-Playback
£ DEP Manager
4 Output
ASI0

Shel Integration
(- Tools
SACD

ASIO Driver Mod

PCM Volume:

PCM Samplerate: -17ﬁ400
DSD2PCM Mode: | Direct (Double-Precision, 30kHzLF v || Load

save
Preferable Area:

[ Editable Tags
[ Edited Master Playback

) [ Cl=
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IMPORTANT SAFETY INSTRUCTIONS

CAUTION

RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF
ELECTRIC SHOCK, DO NOT REMOVE
COVER (OR BACK). NO USER-SERVICEABLE
PARTS INSIDE. REFER SERVICING TO
QUALIFIED SERVICE PERSONNEL.

* Explanation of Graphical Symbols

The lightning flash with arrowhead symbol, within an
equilateral triangle, is intended to alert you to the
presence of uninsulated “dangerous voltage” within
the product’s enclosure that may be of sufficient
magnitude to constitute a risk of electric shock to
persons.

The exclamation point within an equilateral triangle
is intended to alert you to the presence of important
operating and maintenance (servicing) instructions in
the literature accompanying the appliance.

IMPORTANT

Please record the serial number of this unit in the space
below.

MODEL:

Serial No.:

The serial number is located on the rear of the unit.
Retain this Owner’s Manual in a safe place for future
reference.

N AU A W N -

10

11

12

13

14

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.

Clean only with dry cloth.

Do not block any ventilation openings. Install in accordance
with the manufacturer’s instructions.

Do not install near any heat sources such as radiators, heat
registers, stoves, or other apparatus (including amplifiers)
that produce heat.

Do not defeat the safety purpose of the polarized or
grounding-type plug. A polarized plug has two blades with
one wider than the other. A grounding type plug has two
blades and a third grounding prong. The wide blade or the
third prong are provided for your safety. If the provided plug
does not fit into your outlet, consult an electrician for
replacement of the obsolete outlet.

Protect the power cord from being walked on or pinched
particularly at plugs, convenience receptacles, and the point
where they exit from the apparatus.

Only use attachments/accessories specified by the
manufacturer.

Use only with the cart, stand, tripod,

bracket, or table specified by the

manufacturer, or sold with the apparatus. [

When a cart is used, use caution when
moving the cart/apparatus combination
to avoid injury from tip-over.

Unplug this apparatus during lightning storms or when
unused for long periods of time.

Refer all servicing to qualified service personnel. Servicing
is required when the apparatus has been damaged in any
way, such as power-supply cord or plug is damaged, liquid
has been spilled or objects have fallen into the apparatus, the
apparatus has been exposed to rain or moisture, does not
operate normally, or has been dropped.

A
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We Want You Listening For A Lifetime

Yamaha and the Electronic Industries Association’s Consumer Electronics Group want you to get the most out of your
equipment by playing it at a safe level. One that lets the sound come through loud and clear without annoying blaring or
distortion — and, most importantly, without affecting your sensitive hearing. Since hearing damage from loud sounds is

often undetectable until it is too late, Yamaha and the Electronic Industries Association’s Consumer Electronics Group
recommend you to avoid prolonged exposure from excessive volume levels.

Wantiox
LISTENING

ForALifetime



FCC INFORMATION (for US customers)

1 IMPORTANT NOTICE: DO NOT MODIFY THIS
UNIT!

This product, when installed as indicated in the
instructions contained in this manual, meets FCC
requirements. Modifications not expressly approved by
Yamaha may void your authority, granted by the FCC, to
use the product.

2 IMPORTANT: When connecting this product to
accessories and/or another product use only high quality
shielded cables. Cable/s supplied with this product MUST
be used. Follow all installation instructions. Failure to
follow instructions could void your FCC authorization to
use this product in the USA.

3 NOTE: This product has been tested and found to comply
with the requirements listed in FCC Regulations, Part 15
for Class “B” digital devices. Compliance with these
requirements provides a reasonable level of assurance that
your use of this product in a residential environment will
not result in harmful interference with other electronic
devices.

This equipment generates/uses radio frequencies and, if
not installed and used according to the instructions found
in the users manual, may cause interference harmful to the
operation of other electronic devices.

Compliance with FCC regulations does not guarantee that
interference will not occur in all installations. If this
product is found to be the source of interference, which
can be determined by turning the unit “OFF” and “ON”,
please try to eliminate the problem by using one of the
following measures:

Relocate either this product or the device that is being
affected by the interference.

Utilize power outlets that are on different branch (circuit
breaker or fuse) circuits or install AC line filter/s.

In the case of radio or TV interference, relocate/reorient
the antenna. If the antenna lead-in is 300 ohm ribbon lead,
change the lead-in to coaxial type cable.

If these corrective measures do not produce satisfactory
results, please contact the local retailer authorized to
distribute this type of product. If you can not locate the
appropriate retailer, please contact Yamaha Corporation of
America A/V Division, 6600 Orangethorpe Avenue,
Buena Park, CA 90620, USA.

The above statements apply ONLY to those products
distributed by Yamaha Corporation of America or its
subsidiaries.

FCC CAUTION

Change or modifications not expressly approved by the party
responsible for compliance could void the user’s authority to
operate the equipment.

FOR CANADIAN CUSTOMERS

To prevent electric shock, match wide blade of plug to
wide slot and fully insert.

CAN ICES-3(B)/NMB-3(B)

COMPLIANCE INFORMATION STATEMENT

(DECLARATION OF CONFORMITY PROCEDURE)
Responsible Party: ~ Yamaha Corporation of America A/V Division

Address: 6600 Orangethorpe Avenue, Buena Park, CA
90620, USA

Telephone: 1-714-522-9011

Type of Equipment: Compact Disc Player

Model Name: CD-S3000

This device complies with Part 15 of the FCC Rules.

Operation is subject to the following two conditions:

1) this device may not cause harmful interference, and

2) this device must accept any interference received including
interference that may cause undesired operation of this device.

See user manual instructions if interference to radio reception is

suspected.




ution: Read this before operating your unit.

1 To assure the finest performance, please read this manual
carefully. Keep it in a safe place for future reference.

2 Install this sound system in a well ventilated, cool, dry, clean
place — away from direct sunlight, heat sources, vibration,
dust, moisture, and/or cold. For proper ventilation, allow the
following minimum clearances.

Top: 10 cm (4 in)

Rear: 10 cm (4 in)

Sides: 10 cm (4 in)

3 Locate this unit away from other electrical appliances, motors,
or transformers to avoid humming sounds.

4 Do not expose this unit to sudden temperature changes from
cold to hot, and do not locate this unit in an environment with
high humidity (i.e. a room with a humidifier) to prevent
condensation inside this unit, which may cause an electrical
shock, fire, damage to this unit, and/or personal injury.

5 Avoid installing this unit where foreign objects may fall onto
this unit and/or this unit may be exposed to liquid dripping or
splashing. On the top of this unit, do not place:

— Other components, as they may cause damage and/or
discoloration on the surface of this unit.

— Burning objects (i.e. candles), as they may cause fire,
damage to this unit, and/or personal injury.

— Containers with liquid in them, as they may fall and liquid
may cause electrical shock to the user and/or damage to
this unit.

6 Do not cover this unit with a newspaper, tablecloth, curtain,
etc. in order not to obstruct heat radiation. If the temperature
inside this unit rises, it may cause fire, damage to this unit,
and/or personal injury.

7 Do not plug in this unit to a wall outlet until all connections
are complete.

8 Do not operate this unit upside-down. It may overheat,
possibly causing damage.

9 Do not use force on switches, knobs and/or cords.

10 When disconnecting the power cable from the wall outlet,
grasp the plug; do not pull the cable.

11 Do not clean this unit with chemical solvents; this might
damage the finish. Use a clean, dry cloth.

12 Only voltage specified on this unit must be used. Using this
unit with a higher voltage than specified is dangerous and may
cause fire, damage to this unit, and/or personal injury. Yamaha
will not be held responsible for any damage resulting from use
of this unit with a voltage other than specified.

13 To prevent damage by lightning, keep the power cord
disconnected from a wall outlet or the unit during a lightning
storm.

14 Do not attempt to modify or fix this unit. Contact qualified
Yamabha service personnel when any service is needed. The
cabinet should never be opened for any reasons.

15 When not planning to use this unit for long periods of time (i.e.
vacation), disconnect the AC power plug from the wall outlet.

16 Be sure to read the “Troubleshooting” section in the owner’s
manual on common operating errors before concluding that
this unit is faulty.

17 Before moving this unit, press STANDBY/ON/OFF
downward to turn off this unit and then disconnect the AC
power plug from the AC wall outlet.

18 Condensation will form when the surrounding temperature
changes suddenly. Disconnect the power cable from the
outlet, then leave this unit alone.

19 When using this unit for a long time, this unit may become
warm. Turn the system off, then leave this unit alone for
cooling.

20 Install this unit near the wall outlet and where the AC power
plug can be reached easily.

21 The batteries shall not be exposed to excessive heat such as
sunshine, fire or the like. When you dispose of batteries,
follow your regional regulations.

— Keep the batteries in a location out of reach of children.
Batteries can be dangerous if a child were to put in his or
her mouth.

— If the batteries grow old, the effective operation range of
the remote control decreases considerably. If this
happens, replace the batteries with new one as soon as
possible.

— Do not use old batteries together with new ones.

— Do not use different types of batteries (such as alkaline
and manganese batteries) together. Read the packaging
carefully as these different types of batteries may have
the same shape and color.

— Exhausted batteries may leak. If the batteries have
leaked, dispose of them immediately. Avoid touching the
leaked material or letting it come into contact with
clothing, etc. Clean the battery compartment thoroughly
before installing new batteries.

— If you plan not to use the unit for a long period of time,
remove the batteries from the unit. Otherwise, the
batteries will wear out, possibly resulting in a leakage of
battery liquid that may damage the unit.

— Do not throw away batteries with general house waste.
Dispose of them correctly in accordance with your local
regulations.

This unit is not disconnected from the AC power
source as long as it is connected to the wall outlet, even
if this unit itself is turned off by POWER. In this state,
this unit is designed to consume a very small quantity
of power.

WARNING

TO REDUCE THE RISK OF FIRE OR ELECTRIC
SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN
OR MOISTURE.

CAUTION
Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type.




B Handling the remote control

* The area between the remote control and this unit must be clear
of large obstacles.

Do not spill water or other liquids on the remote control.

Do not drop the remote control.

Do not leave or store the remote control in the following types
of conditions:

— places of high humidity, such as near a bath

— places of high temperature, such as near a heater or a stove
— places of extremely low temperatures

— dusty places

Do not expose the remote control sensor to strong lighting, in
particular, an inverter type fluorescent lamp; otherwise, the
remote control may not work properly. If necessary, position
this unit away from direct lighting.

LASER SAFETY

This unit employs a laser. Due to possible eye injury, only a qualified
service person should remove the cover or attempt to service this
device.

DANGER

This unit emits visible laser radiation when open. Avoid direct
eye exposure to beam. When this unit is plugged into the wall
outlet, do not place your eyes close to the opening of the disc tray
and other openings to look into inside.

CAUTION

Use of controls or adjustments or performance of procedures
other than those specified herein may result in hazardous
radiation exposure.

The laser component in this product is capable of emitting
radiation exceeding the limit for Class 1.

CLASS 1 LASER PRODUCT
LASER KLASSE 1 PRODUKT
LUOKAN 1 LASERLAITE
KLASS 1 LASER APPARAT
PRODUIT LASER DE CLASSE 1

CAUTION - CLASS 3B VISIBLE AND INVISIBLE LASER RADIATION WHEN OPEN.
AVOID EXPOSURE TO BEAM.
VARNING - KLASS 3B SYNLIG OCH OSYNLIG LASERSTRALNING
NAR DENNA DEL AR OPPNAD. STRALEN AR FARLIG.
VARO!  AVATTAESSA OLET ALTTINA LUOKAN 38 NAKYVALLE JA
NAKYMATOMALLE LASERSATEILYLLE. ALA KATSO SATEESEEN.
VARNING - KLASS 3B SYNLIG OCH OSYNLIG LASERSTRALNING
NAR DENNA DEL AR OPPNAD. BETRAKTA EJ STRALEN.
VORSICHT | SICHTBARE UND UNSICHTBARE LASERSTRAHLUNG KLASSE 38
WENN ABDECKUNG GEOFFNET. NICHT DEM STRAHL AUSSETZEN.
ATTENTION - RADIATION VISIBLE ET INVISIBLE CLASSE 3B LORSQUE LAPPAREIL
EST OUVERT. EVITEZ TOUTE EXPOSITION AU FAISCEAU.
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AVOID DIRECT EXPOSURE TO BEAM.

| DANGER - VISIBLE AND INVISIBLE RADIATION WHEN OPEN. I

CAUTION INVISIBLE LASER RADIATION WHEN OPEN
AND INTERLOCKS DEFEATED. AVOID EXPOSURE TO
BEAM.
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